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ABSTRACT 

 
This project introduces an innovative AR application called AR Campus Connect, designed to 

revolutionize the campus experience for Universiti Tunku Abdul Rahman (UTAR) students. 

The project aims to address the prevalent challenges faced by universities students, including 

unfamiliarity with campus structures, lack of awareness about campus events, and limited 

avenues for social interaction. The project adopted the incremental development model of 

Agile development methodology, which involved iterative cycles of specification, 

development and validation. Moreover, the implementation of AR technology relies on the 

integration of the ARCore API. Within this project, the utilization of the geospatial creator tool 

within ARCore facilitates the seamless placement of anchors at arbitrary coordinates. This 

functionality extends beyond ground-level placement, as anchors can also be positioned on 

buildings, enhancing the versatility of the application. By activating their phone's camera, users 

can effortlessly visualize anchor points on nearby buildings and access instant event-related 

information. Notably, the Geospatial Creator tool employs a combination of Visual Positioning 

Service (VPS) and Global Positioning System (GPS) data to achieve high-accuracy Geospatial 

poses. In instances where VPS or GPS data is unavailable, such as when the device is out of 

VPS range or experiencing poor GPS signal, the system seamlessly switches to utilize data 

from the alternate source, ensuring continued accuracy in location tracking. Furthermore, the 

project integrates the Google Maps SDK to provide users with instant access to their current 

location and UTAR building markers. The system also incorporates real-time location updates, 

with the user's location being refreshed every five seconds. This frequent updating ensures that 

users receive accurate and up-to-date information about their whereabouts, facilitating smooth 

navigation and exploration of the campus. AR Campus Connect also introduces two key 

features: Moment and Event. The Moment feature allows users to capture and share significant 

on-campus experiences with peers, enriching their campus life through interactive AR content. 

Meanwhile, the Event feature provides updates and notifications about campus happenings, 

ensuring students stay informed and engaged with their university community. Firebase's 

Cloud Firestore serves as the database solution for this project, providing a cloud-based 

platform for real-time data storage and retrieval. In conclusion, AR Campus Connect represents 

a groundbreaking solution to the challenges faced by UTAR students in navigating and 

engaging with their campus environment by harnessing the power of AR technology and Agile 

development methodologies.    
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Chapter 1 

Introduction 

In this chapter, I present the background and motivation of my research, my contribution to the 

field, and the outline of my thesis. This chapter will also include the statements of the existing 

problems to provide a clear understanding of my research. 

 

1.1  Project Background 

Augmented Reality (AR) is a revolutionary technology that seamlessly blends the virtual world 

with the real world, enhancing people's perception and interaction with the environment. 

Unlike Virtual Reality (VR), which immerses the user in a fully synthetic environment, AR 

enriches the real world by superimposing virtual information, such as graphics, sound, video, 

or GPS data, onto the real world. This integration of virtual and real content has redefined the 

way people interact with the digital and physical world, taking place in real time and accurately 

registered in three dimensions, providing users with a dynamic and interactive experience. AR's 

ability to superimpose digital information onto the physical world allows users to visualize 

data, manipulate virtual objects, and immerse themselves in interactive experiences like never 

before. 

Based on Figure 1.1.1 [1], it can be seen that the number of students enrolled in public higher 

education institutions in Malaysia has increased significantly during the period of 2016-2019. 

There was a massive epidemic in 2020, resulting in a significant decline in enrollment in public 

higher education institutions in Malaysia. Disregarding the factor of the epidemic, one can see 

that the number of enrollments is increasing steadily from year to year. Freshmen generally 

take a few weeks to familiarize themselves with the campus environment. Typically, 

universities would provide freshmen with electronic or hard-copy campus maps to help them 

quickly acquaint themselves with various buildings on campus. However, this approach may 

be less effective as some nooks and crannies may not be labeled on the map, rendering the 

student unable to locate the place. 
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Figure 1.1.1: Number of students enrolled in public higher education institutions in Malaysia 

from 2012 to 2020, by gender. 

Apart from that, Figure 1.1.2 shows that many university students post their final year project 

questionnaires on social media, seeking help from their fellow students to complete the 

questionnaires in order to achieve the minimum required amount of responses. Social media 

has become a major platform for university students to interact with each other, where they not 

only share their opinions but also issues with their coursework. This has also led to a 

phenomenon where their posts do not effectively reach the students in the same school but are 

spread all over the world due to the fact that the audience of social media is very large. 

Therefore, posting through social media may not be the best method for university students 

who simply want to reach their fellow students. 
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Figure 1.1.2: Screenshot of university students online asking people to complete 

questionnaires in the XiaoHongShu application. 
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1.2  Problem Statement 

Based on the research, several problems have been identified that today's university students 

would encounter throughout their university careers: 

1. Students are unable to familiarize themselves quickly and effectively with the 

distribution and structure of the campus area. 

Freshmen are often unfamiliar with the campus structure when they first enrol, which 

results in them having to spend a lot of time looking for and identifying routes to their 

classes. Some of the students may encounter the same issue as they are only familiar 

with the routes to their classrooms and therefore tend to get overwhelmed when a new 

semester starts and the classrooms change to a different building. 

2. Students are not aware of university events in a timely manner. 

Although most of the universities will keep students updated on campus events via 

email, it is inevitable that some students do not have the habit of checking their emails 

and therefore miss out on many opportunities to attend campus events. 

3. Students are unable to reach the majority of students at the same university. 

When a university society organizes a new event, the student committee will be 

responsible for promoting the event to increase its exposure. However, due to the lack 

of opportunities to interact with students from the same school, some of the events were 

little known and therefore not well attended. The same situation happens to final year 

university students, who generally need to collect a large number of questionnaires for 

their final year project. The lack of access to fellow students added to the difficulties of 

their final year project. 
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1.3  Motivation 

In order to solve the problem mentioned in the problem statement, I decided to develop a 

mobile application to assist university students in better adapting to university life. Campus 

applications on the market today have relatively few functions, and some may only have the 

function of signing in for classes without other functions that can help students familiarize 

themselves with the campus and make friends, so university students often encounter 

difficulties in their extracurricular life. They may not be able to fit in well with other students, 

or they may not be able to make many friends because they don't have many opportunities to 

meet new people. The cause of this is the lack of functionality in campus applications that allow 

students to communicate and interact with each other, resulting in a lack of communication 

medium for students. They may also miss many opportunities to participate in campus events 

because they are not notified in time, thus graduating with regrets. This can be avoided if the 

campus application is able to notify the students about the upcoming campus events in a timely 

manner. The goal of this project is to prevent such things from happening, so that all university 

students can have a great university experience and spend their university life happily and 

fulfilling. 
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1.4  Research Objectives 

The primary objective of this project is to develop an innovative application leveraging AR 

technology to quickly familiarise UTAR students with the campus environment. Using their 

mobile devices, students can view AR-based markers that provide detailed information about 

buildings, facilities, and campus landmarks. This immersive experience reduces the learning 

curve for new students, enabling them to adapt to their surroundings swiftly while enhancing 

their confidence and independence in navigating the campus. 

By seamlessly integrating AR technology into the campus lives of students, the application 

aims to revolutionize how they access and engage with campus information and events. 

Through the cameras of their mobile phones, students will be empowered with instant access 

to comprehensive and up-to-date campus information, thereby fostering a more informed and 

connected campus community. By simply pointing their phones towards nearby buildings, 

students can seamlessly view pertinent details about the buildings and events, thereby 

eliminating the need for cumbersome navigation between multiple platforms or physical notice 

boards. This not only enhances efficiency but also enriches the overall campus experience by 

providing students with a dynamic and interactive means of accessing essential information. 

In addition, the application facilitates seamless interaction between students to enhance the 

social aspect of campus life. When a new event is created, other users will see an AR icon on 

the screen in real time, displaying information and the location of the event. This breaks the 

limitations of traditional social applications that only display text notifications, enabling an 

instant, convenient, and immersive way to socialize. If students want to learn more about an 

event, they can simply touch the AR marker on the screen to get detailed information about the 

event. This innovative approach not only increases the visibility of events but also promotes 

spontaneity and serendipity, fostering a culture of exploration and discovery within the campus 

community. 

 

 

  



Bachelor of Computer Science (Honours) 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
    7 
 

1.5  Project Scope and Direction 

1.5.1 Project Scope 

The scope of this project is to strengthen the social connections among UTAR students through 

augmented reality technology, offering convenience to students while also helping them to 

better adapt to campus life. The project will develop a mobile application with several features 

that will not only assist UTAR students in exploring the campus but also allow them to share 

information through the application, which in turn will enhance the cohesion among university 

students. 

Furthermore, campus events are undoubtedly beneficial for university students. The project 

also includes the function of campus event promotion, which allows UTAR students to browse 

nearby campus events in a timely and convenient manner. This can also boost the participation 

of UTAR students in campus events. Remarkably, this project is mainly focused on building 

an Android version for Android users. 
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1.5.2 Project Direction 

1. To provide students with an immersive and seamless campus exploration 

experience through augmented reality. 

An anthropomorphic virtual character would be created to guide users in exploring the 

campus. It could display the information of buildings in front of users, including name, 

faculty, etc., to give the user a clear understanding of each building. Besides, a campus 

map will also be displayed in the application to facilitate users in moving around the 

campus. 

2. To enhance campus social interaction and engagement among students by 

enabling students to share campus-related announcements through the AR 

platform. 

Students are able to post their final year project questionnaires, society event posters, 

or activity booth invitations on the AR noticeboard in the application to attract other 

students' attention and interest. In addition, there would be a notification panel showing 

the ongoing events and upcoming events on top of each of the event halls. Students are 

able to get instant updates of school events without the hassle of checking email or 

social media. 

3. To compare various platforms and tools and determine the best fit for developing 

AR Campus Connect. 

There are many AR development platforms and tools available in the market, each with 

its own advantages and disadvantages. This objective aims to analyze the features of 

each development platform and tool and select the most suitable one for AR Campus 

Connect application development to ensure the development of a user-friendly, feature-

rich application with a clean user interface. 
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1.6  Contributions 

In line with the project's overarching goal, the application will be positioned as a 

comprehensive and user-friendly mobile AR application tailored specifically for UTAR 

students. The application will serve as a multi-functional platform that facilitates meaningful 

connections between UTAR students, enabling them to establish new friendships, expand their 

social networks, and acclimatize to the campus environment. To achieve this, a number of 

important features would be integrated into the application, including a campus tour that would 

allow users to explore their surroundings and familiarize themselves with the various facilities; 

a notice board that will allow students to post information about societies and relevant campus 

information; a campus events feature that will ensure that students are kept up-to-date with the 

active life of the university community, and so on. This project could enhance UTAR students' 

overall university experience and promote a sense of connection and affiliation within the 

campus community. 

 

1.7  Report Organization 

The details of this project are covered in the following chapters. Chapter 2 reviews some of the 

relevant past research and points out the differences between AR notice boards and traditional 

notice boards, as well as emphasizes the features and importance of AR notice boards. Chapter 

3 describes the methodology of developing the AR Campus Connect application and the system 

framework. Chapter 4 presents the system design and its components. Chapter 5 covers the 

implementation of the system, while Chapter 6 focuses on the evaluation and discussion of its 

performance. The final chapter provides a conclusion and recommendations, summarizing the 

key findings and contributions of the project while offering insights and suggestions for future 

work. 
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Chapter 2 

Literature Review 

2.1  Previous Works on Campus Connect Application 

2.1.1 Mobile Campus Touring System for Beijing Normal University, China 

Mobile Campus Touring System [2] is an AR-based campus touring system for cultural activity 

in Beijing Normal University, which consists of two subsystems: AR Displaying system and 

auxiliary collaboration system. The AR Displaying system, which serves as the main function 

of the application, combines the user's location with real-time images, allowing users to capture 

their real-world surroundings through their mobile phone's camera and present location-based 

virtual learning information on the user's phone screen. Users can click on the information of 

interest to begin detailed learning. The auxiliary collaboration system, on the other hand, allows 

users to post comments, follow activities of interest, and rate activities, etc. These features 

enhance collaboration among students and enable them to communicate with other students 

with similar interests on certain cultural activities. 

 

Figure 2.1.1.1: Captured images on the smartphone screen about auxiliary collaboration 

system. [2] 
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When the application is launched, the system will automatically access GPS information and 

then load the point of interest (POI) information corresponding to the user's location. For 

instance, when the user points the mobile phone camera at the library building in the university, 

a virtual object representing the library building will appear on the user's phone screen. The 

user can click on this virtual object to get detailed activity information about the library. 

 

Figure 2.1.1.2: AR and GPS based activity information module for Mobile Campus Touring 

System. [2] 

 

2.1.1.1 Strengths 

Mobile Campus Touring System is able to provide information and activity of various POI on 

campus, enabling students to stay abreast of various campus activities. This is particularly 

beneficial to new students as they can quickly access information about various buildings in 

the campus through simple operations, which will effectively help them familiarize and adapt 

to the campus quickly. In addition, the auxiliary collaboration system allows students to interact 

on cultural activities, which not only enhances bonding among students but also helps them to 

expand their network. 
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2.1.1.2 Weaknesses 

However, the Mobile Campus Touring System does not provide navigation function, hence it 

is considered not comprehensive enough as a campus tour system. For those who are not 

familiar with the campus, such as alumni, parents, or new students, the navigation function can 

be a great convenience as they generally need to find a specific building, such as a dormitory 

or a particular lecture hall once they arrive on campus. Besides, the system does not have the 

feature to filter activity. All upcoming campus activities are displayed in the activity 

information list. Students are unable to filter for activities at a specific time or in a specific 

venue, which can actually cause some problems for students looking for information on a 

specific event. 
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2.1.2 Campus Event App for Bowling Green State University, USA 

Campus Event App for Bowling Green State University [3] is an application mainly used to 

search for events in the vicinity. The application allows users to locate nearby events in real 

time, and also allows them to choose the best route to the selected event using the map 

displayed within the application. There are two ways for users to find events in the application, 

one is through AR and the other is through Event List. If the user chooses AR, one can point 

the phone's camera in any direction, and the nearby events in that direction will appear as virtual 

icons on the user's phone screen, overlaid with the reality. Whereas if the user selects Event 

List, then a list of upcoming events will be displayed. 

 

Figure 2.1.2.1: Two main functions of Campus Event App. [3] 

Regardless of which option the user selects, the system will bring up the event detail screen 

whenever the user clicks on an event displayed on the screen, such as the virtual icon 

representing the event in the AR interface or any event in the event list. The event detail screen 

will display detailed information about the event, such as the event date and time, event 

location, and event description. The bottom of the event detail screen also includes a Map 

button and an Event Link button. The user can click on the Map button to view the exact 

location of the event and get directions from the current location to the event location. When 

the Event Link button is pressed, the user will be taken to the event website (if available). 
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Figure 2.1.2.2: Event detail screen, map, and event link. [3] 

 

2.1.2.1 Strengths 

The Campus Event App has the obvious advantage of allowing users to find information about 

nearby campus events and get directions to the event at any time. Whereas previous 

applications did not allow users to view event information and routes at the same time and 

users had to switch between multiple apps, the Campus Event app saves a lot of hassle by 

allowing users to view event information, locations, and routes within the application. 

 

2.1.2.2 Weaknesses 

While the Campus Event App allows users to view the event's location, it does not have the 

feature to find the distance of every event from the user's current location. As a result, the user 

will need to open the event map one by one to compare the distance of each event to the current 

location. 
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2.1.3 iMAP-CampUS for Macquarie University, Australia 

iMAP-CampUS [4] is designed to provide users with information about various buildings as 

they move around the Macquarie University. The iMAP-CampUS application includes about 

25 various buildings around campus, such as Macquarie Library, Macquarie Theater, and 

Macquarie Hospital. As the user walks around the campus, POI icons of different sizes will 

appear on the user's phone screen, with larger POI icons indicating that the user is closer to the 

building. Furthermore, all POIs on the screen are represented by circular icons to reduce the 

user's cognitive load. 

 

Figure 2.1.3.1: POI size on the user’s phone screen. [4] 

Notably, the iMAP-CampUS application contains a wide range of features that allow the user 

to view detailed information about each POI, get navigation directions to the POI, make phone 

calls, surf the website, send e-mails, and play videos or audios. Users can simply click on the 

POI icon on the screen and a brief information widget (BIW) will pop up, which displays 

detailed information about the POI and several function buttons, such as "Play Audio", "Take 

Me There", etc. Users can click on the buttons to achieve the corresponding functions. 

Moreover, users can also switch to Map View instead of Reality View to view campus-wide 

POIs, which is considered very useful. 
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Figure 2.1.3.2: Map View of iMAP-CampUS. [4] 

 

2.1.3.1 Strengths 

The ability of iMAP-CampUS to provide users with the information about various POI on 

campus can help students to quickly familiarize themselves with the campus environment. 

iMAP-CampUS is also a user-friendly application which allows users to easily reach out to the 

staff of a specific department by calling or emailing them through the application. This is quite 

convenient for students as it eliminates the need to search online for the contact details of a 

specific department when they encounter issues and need assistance. 
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2.1.3.2 Weaknesses 

Although the fact that all POIs in the Reality View are represented by circular icons eases the 

cognitive burden on the user, it has to be admitted that the icons do not represent different 

buildings and can easily cause confusion for the user. Many neighbouring buildings may appear 

in the user's phone screen at the same time, thus if the application does not use different icons 

to represent different POIs, the user may easily click on the wrong icon due to the confusion 

of POIs, which may bring an unpleasant experience to the user. 
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2.1.4 MyARCampus for Patras University, Greece 

MyARCampus [5] is an application designed to facilitate student life at the Patras University 

using AR technology. It provides detailed information about campus buildings and course 

schedules for classrooms, and students can also use the application to access detailed bus 

timetable information for bus stops on campus. Through MyARCampus, students are able to 

access the latest information about university buildings, classrooms, and bus stops by scanning 

them with their mobile phone cameras at any time. However, it is worth noting that the app 

requires students to be connected to the internet in order to use it. 

There are three types of POIs established in MyARCampus: 1) buildings and complexes, 2) 

classrooms, auditoriums, and libraries, and 3) bus stops. Scanning different types of POIs will 

display different information. For example, when the user scans buildings and complexes, a 

link to the department's official website will be displayed. The user could just click on the link 

and the screen will automatically redirect to the relevant website. 

 

Figure 2.1.4.1: Illustration of scenario when a building is recognized. [5] 

When the user scans a classroom, auditorium, or library, the relevant weekly schedule will be 

popped up, so that students can quickly check the usage arrangement of the room for the week. 
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Figure 2.1.4.2: Illustration of scenario when a classroom is recognized. [5] 

Additionally, when a bus stop is detected by the camera, users will be able to view the available 

lines for that bus stop, as well as the timetable and route for each line. This is particularly 

convenient for students who do not have their own transport, as buses might be their main mode 

of transport, hence the ability to view bus routes and timetables quickly and easily could bring 

a great deal of convenience to their campus life. 

 

Figure 2.1.4.3: Illustration of scenario when a bus stop is recognized. [5] 
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2.1.4.1 Strengths 

MyARCampus covers not only POIs of buildings on campus but also POIs of bus stops, which 

is a rarity in any campus application on the market. Additionally, MyARCampus allows users 

to view classroom and bus schedules at any time (online), greatly facilitating course attendance, 

navigation, and on-campus transport. Students can also organize and manage their schedules 

better through the application. 

 

2.1.4.2 Weaknesses 

MyARCampus has one major drawback, which is it does not support online database to update 

the information. This implies that if MyARCampus were to be extended to other POIs, the 

information would need to be provided in the form of printed, static announcements. This is 

relatively inflexible and the information may not be updated in a timely manner. 
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2.1.5 Bangor CampusConnect for Bangor University, United Kingdom 

Bangor CampusConnect [6] is the official Bangor University application that allows new 

students to connect with other students who will be studying at Bangor University and access 

information about the university, including announcements, maps, accommodation, and more. 

New students can download the application before their program started, and it will display 

important university news and Welcome Week information to assist new students in getting a 

head start on student life and the process of commencement. 

The Bangor CampusConnect application has the Groups feature that allows users to create a 

variety of groups to congregate other students with the same hobbies or interests. University 

societies can create society communication groups within the application to facilitate 

communication with society members and organization of society events. In addition, new 

students can use this feature to form exploration groups to gather other students to explore the 

campus and its surroundings. By using the Groups feature in the Bangor CampusConnect app, 

students are able to build their own social network and connect with existing students. 

 

Figure 2.1.5.1: Groups feature in the Bangor CampusConnect application. [6] 
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Apart from this, the Bangor CampusConnect application also includes the Map feature which 

allows users to explore POIs and facilities in the vicinity of the university. Once the user has 

launched the feature, Google Maps will be displayed on the screen with Bangor University and 

neighboring POIs marked on the map, allowing new students to get a full overview of the 

campus environment without having to arrive on campus. This is a valuable feature for new 

students as it provides them with an overview of the campus in advance, saving them a great 

deal of time when they enter the university in the future. 

 

Figure 2.1.5.2: Map feature in the Bangor CampusConnect application. [6] 

2.1.5.1 Strengths 

Bangor CampusConnect is an application that offers great convenience to new students, with 

the advantage of allowing them to quickly integrate into the campus even before their program 

started. The application allows new students to interact with existing students and connect with 

other new students, which could effectively mitigate their nervousness at the time of 

enrollment. 
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2.1.5.2 Weaknesses 

The Bangor CampusConnect application's shortcoming is that it does not provide students with 

detailed information about the buildings within the campus. If new students are provided with 

information about the buildings and facilities on campus in advance, they could have a much 

smoother time finding their classrooms at the beginning of the program instead of having to 

spend a lot of time looking around. Through Google Maps in the application, users could only 

know the POIs around the university, but not the buildings and facilities in the campus, hence 

they have to wait until the time of admission to explore the campus. 
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2.2  Summary of Previous Studies 

Table 2.2.1 shows the comparison between existing systems and the proposed system. The 

existing systems used in comparison include Mobile Campus Touring System, Campus Event 

App, iMAP-CampUS, MyARCampus, and Bangor CampusConnect. It can be seen from the 

table that all the existing systems used in comparison have their own strengths, but none of 

them are able to integrate the campus tour and campus connect features well. 

Some systems focus only on the campus tour feature, such as iMAP-CampUS and 

MYARCampus. Each of them could provide users with detailed information about POIs, but 

they do not allow users to interact with other people or view university announcements. It is 

undeniable that the campus tour feature they provide is fairly practical for students, but the lack 

of comprehensive functionality also leads to a lack of opportunities for students to 

communicate and interact with other students. In addition, Mobile Campus Touring Sysem and 

Campus Event App provide campus event features that allow students to access campus events 

at any time, which facilitates attendance of campus events as well as enhances students' 

enthusiasm for learning. It is worth noting that Mobile Campus Touring Sysem has more 

sophisticated features than Campus Event App, which allows students to interact within the 

application, such as leaving comments under the event details. By doing so, students have the 

opportunity to get to know each other through campus events, expanding their network and 

enriching their university life. However, neither of these applications also supports students 

viewing university announcements through the applications. While Bangsor CampusConnect 

is an excellent campus connect application that allows students to stay in touch with their peers 

at any location, it is not equipped with campus navigation feature nor AR technology, and 

therefore is not able to assist students in exploring and discovering the campus. 
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     Application 

 

Feature 

Mobile 

Campus 

Touring 

System 

Campus 

Event 

App 

iMAP-

CampUS 

MyAR 

Campus 

Bangor 

Campus 

Connect 

Proposed 

System 

AR Technology Yes Yes Yes Yes No Yes 

Tracking 
Marker-

less 

Marker-

less 

Marker-

less 

Marker-

based 
N/A 

Marker-

less 

POI Info Yes No Yes Yes No Yes 

Navigation No Yes Yes No No Yes 

Campus Event Yes Yes No No No Yes 

Comment Yes No No No No Yes 

Able to establish 

post 
Yes No No No No Yes 

Able to view 

university 

announcement 

No No No No Yes Yes 

Able to work 

without present in 

campus vicinity 

Yes Yes Yes No Yes Yes 

Table 2.2.1: Comparison based on features in campus connect applications. 
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2.3  Comparison between AR Notice Board and Traditional Notice Board 

The evolution of AR technology has opened up various opportunities and transformed 

lifestyles, offering a novel experience to humanity. Among these advancements, the emergence 

of AR notice boards stands out prominently. Comparing AR notice boards to traditional 

counterparts, be they physical or digital, reveals several distinct advantages across multiple 

dimensions. These include enhanced accessibility, heightened interactivity, increased 

versatility, reduced environmental impact, and increased cost-effectiveness.    

Firstly, in terms of accessibility, traditional notice boards, whether physical or digital, are 

constrained by their static nature. Physical notice boards necessitate a physical presence, 

limiting access primarily to individuals within close proximity. Similarly, while digital notice 

boards may extend accessibility to remote users through online platforms, they still require 

active engagement with the digital interface, such as accessing a website or application. In 

contrast, AR Notice Boards leverage augmented reality technology to provide users with 

immediate access to information overlaid onto their physical surroundings, transcending 

geographical barriers and offering a seamless user experience. By integrating information 

directly into the user's environment via smartphones or AR-enabled devices, AR Notice Boards 

provide unrivaled accessibility, ensuring that users can access relevant information effortlessly, 

regardless of their location.    

Furthermore, interactivity constitutes a significant point of departure between AR Notice 

Boards and traditional counterparts. Physical notice boards typically offer limited interactivity, 

allowing users to view posted notices but offering little opportunity for engagement or 

interaction. Digital notice boards, while more interactive than their physical counterparts, often 

provide standard features such as scrolling through content or clicking on links. In contrast, 

AR Notice Boards introduce a dynamic layer of interactivity, enabling users to engage with 

digital content overlaid onto physical objects or locations in real-time. Users can interact with 

AR markers to access additional information, participate in interactive experiences, or even 

contribute their own content, fostering a more engaging and immersive user experience.    
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Moreover, the versatility of AR Notice Boards far surpasses that of traditional notice boards. 

Physical notice boards are typically limited by the available physical space and are static in 

nature, requiring manual updating and maintenance. Digital notice boards offer greater 

flexibility in terms of content management and updating but are still confined to digital displays 

or screens. AR Notice Boards, on the other hand, leverage the flexibility of digital content 

while seamlessly integrating it into the physical environment. This fusion of digital and 

physical worlds enables AR Notice Boards to adapt dynamically to changing information and 

contexts, providing a versatile platform for disseminating a wide range of content, from event 

announcements and campus updates to interactive advertisements and multimedia 

presentations.    

In addition, considering environmental impact, traditional notice boards, particularly physical 

ones, incur significant resource consumption and environmental footprint. Physical notice 

boards require paper, printing materials, and regular maintenance, contributing to paper waste 

and environmental degradation. While digital notice boards reduce paper usage, they still rely 

on electronic displays, consuming electricity and contributing to electronic waste. In contrast, 

AR Notice Boards offer a more environmentally sustainable alternative by reducing reliance 

on physical materials and leveraging existing digital infrastructure. By utilizing smartphones 

or AR-enabled devices that users already possess, AR Notice Boards minimize resource 

consumption and environmental impact while delivering information in a more sustainable and 

eco-friendly manner.    

Not only that, but the cost aspect constitutes a significant consideration when comparing AR 

Notice Boards with traditional counterparts. Traditional notice boards, whether physical or 

digital, entail various costs associated with materials, maintenance, and infrastructure. Physical 

notice boards require ongoing expenditures for paper, printing, and maintenance of physical 

displays, while digital notice boards involve upfront investments in hardware, software, and 

ongoing maintenance and support. Conversely, AR Notice Boards offer potential long-term 

cost savings by reducing the need for physical materials, minimizing maintenance 

requirements, and leveraging existing digital infrastructure. Besides, as AR technology 

continues to advance and become more accessible, the cost of implementing AR Notice Boards 

is expected to decrease, making them increasingly cost-effective compared to traditional 

alternatives in the long run. 
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In summary, while traditional notice boards are the traditional means of disseminating 

information, AR notice boards represent a paradigm shift in the way information is accessed, 

interacted with, and experienced. Through its unrivaled accessibility, dynamic interactivity, 

multi-functionality, and cost-effectiveness, AR notice boards provide a transformative 

platform for human communication and participation with the environment, heralding the 

arrival of a new era of immersive interactive environments. 

 

2.4  Proposed Solutions 

In response to the shortcomings observed in existing systems, this project aims to introduce a 

mobile AR application that seamlessly integrates campus navigation and campus connect 

functionalities, thereby enhancing UTAR students' university experience. By incorporating an 

AR notice board feature, students will not only be able to navigate the campus but also engage 

in interactive experiences, facilitating connections with peers across different courses. This 

proposed system will offer interactive features enabling students to exchange information and 

interact with peers seamlessly. Moreover, the inclusion of a campus navigation feature will 

expedite the process of familiarizing new and existing students with campus structures. 

Additionally, a unique aspect of this system will be the ability for students to establish posts, 

providing a platform for university societies to promote their activities and enabling students 

to distribute surveys and questionnaires. Ultimately, this comprehensive system aims to 

empower students in various facets of their university life, offering a more convenient and 

efficient university experience, while leveraging the benefits of AR technology. 
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Chapter 3 

System Methodology 

3.1  Methodology 

There are various models in Agile development methodology, this project adopted the 

incremental development model of Agile development methodology as it has a great advantage 

that the development activities can be carried out concurrently and continuously produce 

numerous versions of the system. This allows developers to make improvement on the initial 

version and repeat the process in a continuous loop, eventually generating the final version of 

the system. The incremental development model could be split into several phases such as 

outline description, specification, development, and validation. 

 

Figure 3.1.1: Project workflow in incremental development model. 
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• Outline Description 

As the initial phase of the project development, the system requirements are gathered 

during this phase. All functional and non-functional requirements are documented and 

subsequent incremental features of the system are added based on the importance of the 

requirement. The AR Campus Connect system has some basic requirements, for 

instance: 

1. Students should be able to view buildings information. 

2. Students should be able to view the university map. 

3. Students should be able to view campus events. 

4. Students should be able to create new campus events. 

5. Students should be able to establish posts. 

6. Students should be able to comment on posts. 

7. Students should be able to like posts. 

8. Students should be able to dislike posts. 

9. Students should be able to receive notifications. 

 

• Specification 

In this phase, the AR Campus Connect system specifications are determined. It is also 

necessary to identify issues such as what tools and technologies will be required for the 

project, who will be the users of the AR Campus Connect system and where and when 

the system will be used, etc. at this phase. At the moment, our target users are UTAR 

students and the application should be used on campus. 

 

• Development 

The coding is performed in the development phase, by using Unity. The main 

programming language adopted in this project is C# as it is the dominant scripting 

language for the Unity. 

 

• Validation 

During the validation phase, the performance of the AR Campus Connect system and 

the extent to which the system meets the requirements will be validated. 
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3.2  System Design Diagram 

3.2.1 Use Case Diagram 

Figure 3.2.1.1 illustrates the use case diagram for the AR Campus Connect System, showcasing 

the interactions between various actors and system functionalities. The main actors in the 

system include the User and Admin, with both Student and Organization categorized as User. 

Each actor engages with distinct components of the application based on their respective roles 

and responsibilities. 

Users have access to several core functions within the AR Campus Connect application. They 

can view information about campus buildings by interacting with AR markers, which enhances 

their understanding of the campus layout. Additionally, users can utilize the navigation feature 

to help them move around the campus. The application also allows users to visit the building 

website with just a click. Users are kept informed of campus events by viewing the latest 

updates through AR markers. They also have the ability to create new events, sharing them 

with the broader campus community. Moreover, users are enabled to manage posts within the 

application, which includes the ability to establish new posts, like or dislike posts, and comment 

on existing posts. These features help facilitate social interaction and engagement within the 

campus environment. Notably, for actions such as liking or disliking posts and commenting on 

them, notifications are automatically generated and sent to the relevant users to ensure that 

users remain engaged and up-to-date. Authentication is also required each time users execute 

actions within the post management system. 

Furthermore, The Admin role possesses more extensive control over the system’s content and 

users. Admins are responsible for updating building information to ensure that students have 

access to the latest details about campus facilities. Additionally, admins could manage the 

system's users, including responsibilities such as role assignments and access control. 

 



Bachelor of Computer Science (Honours) 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
    32 
 

 

Figure 3.2.1.1: Use Case Diagram. 
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3.2.2 Activity Diagram 

Figure 3.2.2.1 illustrates the flow of interactions between users and the AR Campus Connect 

System for various functionalities related to building information, events, and posts. The 

diagram is divided into two swim lanes: one representing user and the other representing the 

AR Campus Connect System. 

The process begins with the localisation system, which plays a crucial role in identifying the 

user's position within the campus. This step forms the foundation for the AR Campus Connect 

System to function effectively. If localisation is successful, the user can interact with the 

various anchors; if not, the system will terminate and not proceed with displaying relevant 

information. Once the localisation is successful, the system displays different types of anchors 

including building info anchor, event anchor, and post anchor. 

After the user clicks the building anchor, the system will display the building information, and 

if the user chooses to view additional details, they can click a button to either display the 

website or navigate to the location via Google Maps. 

For events, when the user clicks an event anchor, the system displays event details and allows 

the user to create new events. The process of uploading an event is facilitated by the system 

after the user submits the necessary information, which is then stored in the Firebase. This 

ensures that new events are updated and accessible to other users through event anchors. 

The figure also outlines how the system handles user interaction with posts. When the user 

clicks on a post anchor, the system displays the post details. If the user chooses to interact with 

the post by liking, disliking, or commenting, the system first verifies the user's authentication 

status. If the user is logged in, they can proceed to interact with the post. However, if the user 

is not logged in, the system redirects them to the login process. If the user does not have an 

account, they are prompted to register before proceeding. Successful login or registration 

allows the user to update post details by interacting with the post. 
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Figure 3.2.2.1: Activity Diagram. 
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Chapter 4 

System Design 

4.1  System Flowchart 

Figure 4.1.1 depicts the process flow for user interaction within the AR Campus Connect 

System, starting with the localisation of the user's device to ensure proper functionality. If the 

localisation is unsuccessful, the process ends there. However, if localisation is successful, the 

system proceeds by displaying various anchors including building info anchor, event anchor, 

and post anchor. 

The first set of actions is based on whether the user wants to interact with post anchors. If the 

user selects a post anchor, the system displays the relevant post details, allowing the user to 

engage with the post. For example, users can express their reactions by liking, disliking, or 

commenting on an existing post. Additionally, they have the option to create a new post. To 

carry out these actions, authentication is required to verify their authorisation. If the user is 

logged in and authenticated through Firebase, the post details are updated accordingly. If the 

user does not have an account, they will be redirected to register page before proceeding. 

In the case of event anchors, the user can either create a new event or view details of an existing 

one. Similar to the post anchor flow, the system authenticates the user before allowing the 

creation of new events. Upon successful authentication, event details are updated in Firebase, 

ensuring real-time synchronization of data. 

Additionally, the system supports interaction with building information anchors. When the user 

clicks on a building information anchor, the system displays information related to that building. 

From this point, the user can either be redirected to the building’s website or to Google Maps 

for navigation, depending on the chosen action. This provides an interactive and user-friendly 

method for users to access essential campus information. 
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Figure 4.1.1: System Flowchart. 
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4.2  System Components Specifications 

4.2.1 Unity 

The system components for the AR Campus Connect application are organized within the 

Unity hierarchy under the main root object labeled “AR Campus Connect”, which functions as 

the container for all key elements. It’s worth mentioning that one of the primary components 

is the XR Origin, responsible for managing the position and orientation of the user's AR view. 

Nested within this is the Camera Offset, containing the Main Camera that renders the 

augmented reality environment, ensuring a seamless AR experience for the user. Additionally, 

the AR Session object handles the lifecycle of the AR session, while ARCore Extensions 

provides advanced ARCore functionalities to enrich the AR experience. 

The Canvas object is integral to the user interface, hosting multiple panels that facilitate 

interaction. These include ARView, which manages user interaction with the AR environment, 

and AvailabilityCheck, responsible for checking the availability of VPS services. The 

PrivacyPrompt panel displays necessary privacy notifications, while Dashboard, SignUp, and 

LogIn provide navigation and user account management functionalities, forming the core of 

the application's interface for user engagement. 

EventSystem is used to handle all input events, which allows for seamless interaction between 

the user and the AR objects or UI elements. The GeospatialController manages geospatial 

functionalities, leveraging ARCore’s geospatial API to ensure accurate positioning and 

placement of AR elements relative to real-world coordinates. This is complemented by the AR 

Geospatial Creator Origin, which contains the Cesium3DTileset. The tile set plays a crucial 

role in rendering extensive geographical data within the Unity editor, which significantly aids 

developers by streamlining the programming process. 

To enable users to view AR elements in a real-world environment, it is essential to incorporate 

geospatial creator anchors. I have added multiple anchors to the system, each positioned at 

various buildings on campus. For instance, I created an anchor named “Block N” to represent 

the location at Block N. I then included elements such as “Block N Post” and “BuildingEvent,” 

each of which presents different canvases and information to the user. Users can interact with 

these elements by clicking on them. 
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Figure 4.2.1.1: Unity hierarchy. 
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4.2.2 Firebase 

Firebase serves as the primary database for the AR Campus Connect System, providing a 

versatile and scalable backend solution. It provides an efficient platform for managing various 

aspects of data handling, such as user authentication, real-time data operations, and storage, 

making it highly suitable for this AR-driven application. A critical feature employed within the 

system is Firebase Authentication, which ensures user credentials are properly validated before 

granting access to specific functionalities. This includes actions like liking or disliking posts, 

commenting on existing posts, and other interactive features. By implementing Firebase 

Authentication, the system guarantees that only verified users can modify data, such as creating 

new campus events or engaging with posts through comments and reactions. 

 

Figure 4.2.2.1: Firebase Authentication. 

Beyond user authentication, the system utilizes Firebase Cloud Firestore to store user-specific 

information, including personal details and like or dislike counts. Firestore’s real-time 

synchronization feature allows for instantaneous updates throughout the application, ensuring 

users have access to the most up-to-date information. This is particularly useful in a dynamic 

environment like a campus, where events, posts, and interactions are frequently updated. 
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Figure 4.2.2.2: Firebase Cloud Firestore. 

Furthermore, Firebase Storage is employed to manage multimedia content, including campus 

buildings images and user profile pictures. The flexibility of Firebase Storage also facilitates 

the storage and retrieval of profile pictures, enhancing the user experience by providing 

personalized visuals tied to user accounts. This seamless integration of Firebase's various 

services contributes to the smooth operation of the AR Campus Connect System, ensuring data 

security, real-time functionality, and efficient storage management. 

 

Figure 4.2.2.3: Firebase Storage. 
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Chapter 5 

System Implementation 

5.1  Hardware Setup 

The hardware involved in this project includes a laptop and an Android mobile device. The 

laptop is used for development and programming of the application whereas the mobile device 

is used for testing and deploying this mobile AR application in the campus area. In order to 

deploy the AR Campus Connect application, it is required to ensure that the device is ARCore 

supported and a USB cable is prepared for connecting the device to the development laptop. 

Description Specifications 

Model Asus Zenbook UX425EA 

Processor 11th Gen Intel(R) Core(TM) i7-1165G7 @ 2.80GHz 

Operating System Windows 10 

Graphic Intel ® Iris ® Xe Graphics 

Memory 8GB RAM 

Storage 512GB SSD 

Table 5.1.1: Specifications of laptop. 

Description Specifications 

Model Oppo F11 Pro 

Processor Mediatek MT6771 Helio P70 

Operating System Android 

Graphic Mali-G72 MP3 

Memory 8GB RAM 

Storage 128GB 

Table 5.1.2: Specifications of mobile device. 
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5.2  Software Setup 

The project is developed with several technologies, such as ARCore, Google Maps, Unity, C# 

and Firebase.  

• ARCore 

ARCore is an augmented reality development framework on the Google platform. This 

project adopted its application programming interface (API) and utilized it to build an 

augmented reality experience in the system. Through this technology, the AR Campus 

Connect application enabled the placement of markers in the real world and allowed 

users to interact with them. It can be said that the technology is the core of the project. 

• Google Maps 

Google Maps is a web mapping platform provided by Google that provides detailed 

information about geographic regions and sites around the world. The AR Campus 

Connect application allows users to navigate around campus using the Google Maps 

SDK to quickly locate campus buildings on a map and easily navigate to them. 

1. Unity 

Unity, a robust game engine created by Unity Technologies, was my tool of choice for 

developing the AR Campus Connect application. To effectively implement AR features, 

it was necessary to use Unity version 2021.3 or later, along with Android Build Support. 

• C# 

Unity's native support for the C# programming language made it the ideal choice for 

developing the AR Campus Connect application. This compatibility allowed for 

seamless scripting and customization, enabling the creation of complex AR interactions 

and features with greater ease and efficiency. Additionally, the extensive resources and 

documentation available for C# in Unity further streamlined the development process, 

making it easier to troubleshoot, optimize, and enhance the application's functionality. 
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2. Firebase 

Firebase is a cloud-based NoSQL database known for its real-time data synchronization 

and storage capabilities. With its robust features and free tier, it became the ideal 

solution for managing and storing data in the AR Campus Connect application. 
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5.3  Setting and Configuration 

1. Install AR Foundation package. 

o Navigate to Window > Package Manager. 

o Next to Packages, select Unity Registry. 

o Type “AR Foundation” in the search bar and click install. 

 

                  Figure 5.3.1: AR Foundation package. 

 

2. Install Google ARCore XR Plugin. 

o Navigate to Window > Package Manager. 

o Next to Packages, select Unity Registry. 

o Type “Google ARCore XR Plugin” in the search bar and click install. 

 

               Figure 5.3.2: Google ARCore XR Plugin. 
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3. Enable Google ARCore. 

Navigate to Edit > Project Settings. In XR Plug-in Management, open the Android tab 

and enable Google ARCore. 

 

                                      Figure 5.3.3: XR Plug-In Management. 

 

4. Configure Player Settings. 

o In Other Settings > Rendering, uncheck Auto Graphics API. 

 

                          Figure 5.3.4: Other Settings > Rendering. 

o In Other Settings > Identification > Package Name, create a unique application 

ID. 

o In Other Settings > Identification > Minimum API Level, specify Android 7.0 

‘Nougat’ (API Level 24) or higher. 

 

                           Figure 5.3.5: Other Settings > Identification. 
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o In Other Settings > Configuration > Scripting Backend, Select IL2CPP instead 

of Mono. 

o In Other Settings > Configuration > Target Architecture, enable ARM64 (64-

bit ARM). 

 

                          Figure 5.3.6: Other Settings > Configuration.             

 

5. Select Android platform. 

o Navigate to File > Build Settings. 

o Select Android. 

o Click “Switch Platform”. 

 

                                        Figure 5.3.7: Build Settings. 
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6. Import ARCore Extensions package. 

o Navigate to Window > Package Manager. 

o Click the “+” button and choose the “Add package from git URL...” option. 

o Paste the URL into the text field: https://github.com/google-ar/arcore-unity-

extensions.git#arf5 

o Click “Add”. 

 

                      Figure 5.3.8: Add package from git URL… 

 

7. Setup scene. 

o In Hierarchy pane, add AR Session, XR Origin (Mobile AR) and ARCore 

Extensions. 

o In Project > Assets pane, right-click and select Create > XR > ARCore 

Extensions Config. 

o In Project > Assets pane, right-click and select Create > XR > Camera Config 

Filter. 

o In Hierarchy pane, select the ARCore Extensions package. 

o In Inspector pane, for each of the following fields, click the target button, and 

connect each field with its corresponding game object, as follows: 

i. Session: Use scene's AR Session. 

ii. XR Origin: Use scene's XR Origin. 

iii. Camera Manager: Use scene's AR Camera. 

iv. ARCore Extensions Config: Use ARCoreExtensionsConfig asset. 

v. Camera Config Filter: Use ARCoreExtensionsCameraConfigFilter asset. 
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      Figure 5.3.9: Inspector pane of ARCore Extensions. 

 

8. Setup API. 

o Set up API access to use the ARCore Geospatial API 

o Set up API access to use the Google Map Tiles API. 

 

9. Enable Geospatial. 

o Navigate to Edit > Project Settings > XR Plug-in Management > ARCore 

Extensions, enable Geospatial. 

o Enter API credentials. 

 

10. Add required dependencies. 

o Download the most recent version of the precompiled .tgz of Cesium for Unity 

from their GitHub Releases page. 

o Navigate to Window > Package Manager. 

o Click the "+" button and choose "Add package from tarball". 

o Select the downloaded Cesium for Unity .tgz file. 

o Install additional dependencies as prompted, such as Text Mesh Pro. 

 



Bachelor of Computer Science (Honours) 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
    49 
 

11. Enable Geospatial Creator. 

o Navigate to Edit > Project Settings > XR Plug-in Management > ARCore 

Extensions, enable Geospatial Creator. 

o After enabling the Geospatial Creator toggle, a non-modal wizard will be 

displayed to confirm that the project is compatible with the Geospatial Creator. 

o Click "Finish”. 

o After finishing the wizard, Unity will trigger a compilation of scripts. Wait for 

the recompilation to complete. 

 

                          Figure 5.3.10: ARCore Extensions Settings. 

 

12. Add Geospatial Creator Origin. 

o In Hierarchy pane, add Geospatial Creator Origin, then select it. 

o In Hierarchy pane, select the Geospatial Creator Origin. 

o In Inspector pane, add a georeference by clicking the “Add Cesium 

Georeference Component” button. 

o Insert the API key. 

o Set up the latitude, longitude and height fields. 

 

13. Add and place Geospatial Anchor. 

o In Hierarchy pane, add Geospatial Creator Anchor, then select it. 

o In Inspector pane, specify latitude, longitude and height. 
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5.4  System Operation 

5.4.1 Sign Up 

AR Campus Connect features a sign-up function that streamlines the account creation process 

for new users. As part of this process, users are asked to provide a username, email address, 

password, and confirm their password. The email address acts as a unique identifier within the 

application, with each email being permitted for registration only once. 

The password and confirm password fields are included to enhance security by ensuring that 

users set a strong and consistent password for their accounts. This dual-entry process helps 

prevent errors and ensures that the password is entered correctly, contributing to the overall 

security of user accounts. Once the required information is submitted and validated, users can 

successfully create an account, gaining access to the full range of features offered by AR 

Campus Connect. 

       

Figure 5.4.1.1: Sign up page. 
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5.4.2 Log In 

The login page of AR Campus Connect requires users to enter their email address and password 

to access their accounts. This straightforward login process ensures secure entry to the 

application by verifying the user's credentials. For added convenience, the page also features a 

"forgot password" function. This function allows users who have forgotten their password to 

securely reset it. By following a simple recovery process through email, users can regain access 

to their accounts without compromising security. 

      

Figure 5.4.2.1: Log in page. 
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5.4.3 Moment 

The Moment feature in AR Campus Connect provides users with a dynamic platform for 

social interaction and engagement. Through this feature, users can create posts, which allows 

them to share updates or thoughts with the community. Additionally, users have the ability to 

interact with existing posts by liking, disliking, or commenting, thereby expressing their 

opinions and engaging in discussions. The Moment page serves as a central hub where users 

can view and interact with posts made by others. This page is designed to foster a sense of 

community and encourage active participation, as users can explore a variety of posts, stay 

informed about what their peers are sharing, and contribute to the conversation through their 

interactions. 

     

Figure 5.4.3.1: Moment. 
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5.4.4 Event 

The Event page in AR Campus Connect offers a comprehensive platform for users to stay 

updated on campus activities and contribute to the campus community by creating new events. 

Users can browse through a list of all upcoming events, providing them with valuable 

information about various campus activities, gatherings, and opportunities.  

In addition to viewing events, users have the capability to create new events, which requires 

entering specific information to ensure the event is properly described and organized. To create 

a new event, students are required to input several key details: the event title, which provides 

a clear and concise name for the event; the event date, which specifies the scheduled time for 

the event; the event location, which indicates where the event will take place; and the event 

details, which offer a more thorough description and any additional information relevant to the 

event. This structured approach to event creation ensures that all pertinent information is 

captured and presented clearly, facilitating effective communication and organization of 

campus events. 

       

Figure 5.4.4.1: Event. 
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5.4.5 Map View 

The map view in AR Campus Connect is designed to provide users with an intuitive and 

interactive navigation experience across the UTAR campus. Prominent markers are 

strategically placed to represent key UTAR buildings, offering users clear and immediate visual 

cues for orientation and navigation. 

Users can engage with these markers effortlessly by clicking on them, which triggers the 

display of detailed information about each building. The interactive nature of the map view not 

only simplifies navigation but also enriches the user's understanding of the campus layout and 

the purpose of each building. 

      

Figure 5.4.5.1: Map view. 

  



Bachelor of Computer Science (Honours) 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
    55 
 

5.4.6 AR View 

When using the application in AR View throughout the UTAR campus, users will come across 

AR notice boards strategically placed on nearby buildings. These virtual notice boards are 

seamlessly integrated with the physical UTAR structures, offering students real-time updates 

on upcoming events and recent moments shared within the community.  

As users navigate the campus and encounter these AR notice boards, they can interact with 

them by clicking on the corresponding anchors. This action activates a page redirection 

function that provides detailed information relevant to the notice board's content. This 

integration of augmented reality with physical locations ensures that users receive timely and 

pertinent information directly within their campus environment, enhancing their engagement 

and awareness of campus activities. 

      

Figure 5.4.6.1: AR view. 
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5.4.7 User Profile 

The user profile provides a comprehensive view of individual user information, serving as a 

personalized hub for managing account details. This profile displays essential elements 

including the user's username, profile picture, description and account creation time. To further 

enhance user interaction, the profile page also features a count of likes and dislikes accumulated 

by the user, reflecting their activity and engagement within the application.  

Moreover, users are empowered to manage and update their account information directly 

through the profile page. By inputting the relevant details into the designated fields and clicking 

the update button, users can modify their profile information, ensuring that their data remains 

current and accurate. This functionality provides users with control over their profiles, enabling 

them to make adjustments as needed and maintain an up-to-date representation of their 

information within the application. 

 

Figure 5.4.7.1: User profile. 
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5.5  Implementation Issues and Challenges 

The primary implementation challenges encountered in this project revolve around the 

development of the AR session. As a newcomer to AR technology, navigating the complexities 

of implementing AR features posed a significant learning curve. Overcoming technical hurdles 

such as integrating AR functionalities seamlessly with the existing application framework 

required extensive research, experimentation, and troubleshooting. This took up a lot of my 

time and effort, and in fact slowed down my development progress due to frequent bugs in AR 

session. 

Despite these challenges, one novel aspect of this project lies in the implementation of an 

interactable AR notice board. This innovative feature enhances user engagement by allowing 

users to interact with virtual notice boards overlaid onto physical structures within the campus 

environment. By leveraging AR technology, users can access real-time information, 

announcements, and updates directly within the context of their surroundings. This novel 

approach not only enhances the usability and effectiveness of traditional notice boards but also 

showcases the transformative potential of AR in augmenting everyday experiences. 

 

5.6  Concluding Remark 

In summary, the development of the AR Campus Connect application was an intricate process 

involving both hardware and software elements. The setup and configuration of the system 

demanded meticulous attention to detail to meet the precise requirements of augmented reality 

technology. Despite facing various issues and challenges during development, these were 

effectively addressed through ongoing iterative improvements and testing, leading to the 

creation of a functional and robust system. 
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Chapter 6 

System Evaluation and Discussion 

6.1  System Testing and Performance Metrics 

Response Time 

Response time is a critical metric for evaluating the performance of the AR Campus Connect 

application. It measures the duration between a user’s action, such as reacting to a post, 

submitting a new event or interacting with an AR element, and the application's response. 

During testing, the application’s response time was closely monitored to identify and address 

any delays that could affect user satisfaction. 

Error Rate 

The error rate quantifies the frequency of errors encountered during the use of the AR Campus 

Connect application, including issues such as failed interactions, system crashes, or incorrect 

data display. A low error rate is crucial for ensuring the reliability and stability of the 

application. Comprehensive testing was conducted to detect and rectify bugs or glitches that 

could impact functionality. 

Resource Utilisation 

Resource utilisation measures how efficiently the AR Campus Connect application uses system 

resources such as CPU, memory, and battery power, especially on mobile devices. Since AR 

applications typically require substantial processing power and memory to render AR elements 

and manage real-time data, it's essential to ensure the application doesn't overuse these 

resources, leading to lag, overheating, or excessive battery drain. By tracking resource 

utilization during testing, potential inefficiencies can be identified and optimized to improve 

the application's overall performance, ensuring a smooth user experience even on lower-end 

devices. 
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6.2  Testing Setup and Result 

Table 6.2.1 shows the testing setup and result obtained. In summary, the testing of the AR 

Campus Connect application yielded valuable insights into the performance metrics for various 

user actions. The response time for most actions was within acceptable limits, with interactions 

like liking or disliking a post achieving quick responses of 0.8 to 0.9 seconds. More complex 

actions such as creating a new post or event took slightly longer, averaging between 2.5 to 2.7 

seconds. Overall, the system performed reliably, with the majority of actions completing 

successfully and minimal errors reported. 

The error rate for all tested actions was predominantly low, with only one failure occurring out 

of fifty attempts. This indicates a high level of system stability. The resource utilization metrics 

showed that while CPU and memory usage were generally efficient, certain actions, such as 

creating new posts and events, resulted in higher CPU utilization and memory consumption. 

Battery consumption was also notably higher during these more intensive actions. 

These results provide a comprehensive overview of the AR Campus Connect application's 

performance across various user interactions. While the system demonstrates robust 

functionality and reliability, areas for optimization have been identified, particularly in 

managing resource usage during more demanding operations.  

User Actions 
Performance 

Metrics 
Testing Setup Result 

Users clicks the 

AR anchors 

Response Time Record the duration 

between user action and 

system response 

1.8 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 35% 

Memory Usage: 150 

MB 

Battery Consumption: 

5% per hour 
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Users like a post 

Response Time 

 

Record the duration 

between user action and 

system response 

0.9 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 20% 

Memory Usage: 80 

MB 

Battery Consumption: 

2% per hour 

Users dislike a 

post 

Response Time 

 

Record the duration 

between user action and 

system response 

0.8 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 18% 

Memory Usage: 70 

MB 

Battery Consumption: 

1.8% per hour 

Users comment 

on a post 

Response Time Record the duration 

between user action and 

system response 

1.2 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 30% 

Memory Usage: 120 

MB 

Battery Consumption: 

4% per hour 

Users create new 

post 

Response Time Record the duration 

between user action and 

system response 

2.5 seconds 
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Error Rate 
Repeat the action 5 times 4 succeed, 1 failed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 40% 

Memory Usage: 180 

MB 

Battery Consumption: 

7% per hour 

Users create new 

event 

Response Time Record the duration 

between user action and 

system response 

2.7 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 45% 

Memory Usage: 200 

MB 

Battery Consumption: 

8% per hour 

Users update 

personal details 

Response Time Record the duration 

between user action and 

system response 

1.4 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 25% 

Memory Usage: 100 

MB 

Battery Consumption: 

3% per hour 

Users sign in 

Response Time Record the duration 

between user action and 

system response 

2 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 

Monitor the CPU, 

memory and battery 
CPU utilization: 30% 



Bachelor of Computer Science (Honours) 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
    62 
 

consumption while user 

perform the action 

Memory Usage: 140 

MB 

Battery Consumption: 

6% per hour 

Users sign up 

Response Time Record the duration 

between user action and 

system response 

2.3 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 35% 

Memory Usage: 160 

MB 

Battery Consumption: 

6.5% per hour 

Users log out 

Response Time Record the duration 

between user action and 

system response 

1.2 seconds 

Error Rate 
Repeat the action 5 times 5 succeed 

Resource 

Utilisation 
Monitor the CPU, 

memory and battery 

consumption while user 

perform the action 

CPU utilization: 15% 

Memory Usage: 60 

MB 

Battery Consumption: 

2% per hour 

Table 6.2.1: Testing setup and result. 

 

  



Bachelor of Computer Science (Honours) 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
    63 
 

6.3  Project Challenges 

One of the primary challenges I faced was the significant lag in Unity. At times, the build and 

run process would take between 1 to 3 hours, which severely impacted both development and 

debugging efficiency. This lag not only extended the time required to see changes in the 

application but also disrupted the iterative testing and refinement process. The slow build times 

made it difficult to quickly address issues and implement new features, ultimately slowing 

down overall progress. To mitigate this challenge, I explored various optimization strategies, 

such as optimizing scripts, but the lag remained a persistent issue that required careful 

management and patience. 

The second major challenge was managing the AR session within the application. The 

complexity of AR technology meant that even when the application was not in AR view, 

interactions with other non-AR elements were sometimes inadvertently affected. This issue 

arose from the intricate interplay between AR and non-AR components, where the AR 

session’s background processes could influence the behavior of user interface elements or other 

features outside the AR view. Addressing this challenge required thorough debugging and fine-

tuning to ensure that AR interactions did not interfere with the application's general 

functionality. 
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6.4  Objectives Evaluation 

The objective evaluation of the AR Campus Connect application focuses on three critical 

aspects: performance, stability, and usability. These metrics were carefully assessed to ensure 

that the application meets high standards and delivers a satisfactory user experience.  

Performance 

The performance of the AR Campus Connect application was evaluated based on the system's 

ability to complete localisation within a specified timeframe. The application demonstrated 

impressive efficiency, achieving full localization within 2.5 seconds. This rapid localisation is 

essential for minimising delays and enhancing the user experience, as it allows students to 

rapidly identify and interact with key campus features. Efficient performance ensures that users 

can seamlessly navigate and explore their surroundings, supporting the objective of swift 

campus familiarisation. 

Stability 

Stability was assessed by monitoring the application over 50 sessions, during which it 

experienced only 1 crash. This results in a crash rate of 2%, indicating a high level of reliability. 

The low crash rate reflects the AR Campus Connect application's robustness and stability, 

minimizing disruptions for users. Besides, stable performance is crucial for providing 

consistent access to campus information and maintaining an uninterrupted user experience, 

which aligns with the goal of offering reliable, instant information access. 

Usability 

Usability was assessed based on the accuracy of AR object placement and user interaction. The 

AR Campus Connect application generally placed AR objects accurately within the real-world 

environment, facilitating effective interaction with campus features. However, some objects 

occasionally experienced slight deviations from their intended positions, causing minor visual 

shifts. Despite these occasional deviations, the overall usability of the application remains 

strong, allowing students to effectively engage with AR elements.  
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6.5  Concluding Remark 

In conclusion, Chapter 6 has provided a comprehensive analysis of the AR Campus Connect 

application's system testing, performance metrics, project challenges, and objective evaluation. 

The performance metrics indicate that the application achieves efficient localization and 

interaction with minimal delays, contributing to a smooth user experience. The stability 

assessment confirms a high level of reliability, with a low crash rate ensuring consistent and 

dependable performance. Usability findings highlight the application’s effectiveness in placing 

AR objects accurately and maintaining user engagement, despite occasional minor deviations. 

While the application has shown strong results in meeting its objectives, the project also faced 

challenges, such as lag in Unity and managing the AR Session.  

Overall, AR Campus Connect represents a significant step forward in integrating augmented 

reality with campus life, providing UTAR students with valuable tools for navigation, 

information access, and social interaction. 
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Chapter 7 

Conclusion and Recommendation 

7.1  Conclusion 

In conclusion, the development of the AR Campus Connect application represents a significant 

milestone in the realm of campus technology solutions. By harnessing the power of AR 

technology, this project endeavors to revolutionize the way UTAR students navigate and 

engage with their campus environment. 

The identification of key challenges faced by today's university students reveals a multifaceted 

landscape where students grapple with various obstacles in navigating and engaging with their 

academic environment. Chief among these challenges is the issue of unfamiliarity with campus 

structures, which often leaves students feeling disoriented and overwhelmed, especially during 

their initial days on campus. Without a clear understanding of the locations of key buildings, 

facilities, and amenities, students may struggle to find their way around campus efficiently, 

leading to frustration and inefficiency in their daily routines. Moreover, the lack of awareness 

about campus events poses another significant challenge for students. Despite the abundance 

of extracurricular activities, workshops, seminars organized by university and student societies, 

many students remain uninformed or unaware of these opportunities due to inadequate 

communication channels or information dissemination methods. This results in missed 

opportunities for personal and professional development, as well as limited avenues for social 

interaction and community engagement. 

In light of these challenges, there arises an urgent call for innovative solutions that not only 

recognize the complexities of these issues but also proactively address them to empower 

students in their academic journey. The dynamic and rapidly evolving landscape of higher 

education demands innovative approaches that go beyond traditional paradigms and embrace 

cutting-edge technologies and methodologies. These innovative approaches must not only 

target the symptoms of the challenges faced by students but also address the underlying root 

causes to effect meaningful and sustainable change. This requires a comprehensive and holistic 

approach that encompasses various facets of the university experience, including academic and 

social development, and AR Campus Connect application is the answer. 
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The AR Campus Connect application, equipped with innovative AR notice board and map 

view features, offers a transformative solution to address the challenges faced by university 

students. Through the AR notice board feature, students can effortlessly stay informed about 

campus events, announcements, and activities in real-time. By superimposing virtual 

information onto the physical campus environment, the AR notice board provides students with 

instant access to relevant information directly within their surroundings. This eliminates the 

need for students to rely on traditional methods of communication, such as emails or physical 

notice boards, which may be prone to oversight or delay. Additionally, the interactive nature 

of the AR notice board fosters engagement and participation, enabling students to interact with 

and contribute to the campus community in meaningful ways. 

Furthermore, the map view feature of the AR Campus Connect application offers a practical 

solution to the challenge of unfamiliarity with campus structures. By providing students with 

a comprehensive and interactive campus map, complete with building labels and navigation 

tools, the application empowers students to navigate their campus environment with confidence 

and ease. Whether it's finding their way to a specific building for a class or locating facilities 

such as libraries or gates, the map view feature ensures that students have access to the 

information they need to navigate their campus efficiently. Moreover, the real-time updating 

capabilities of the map view feature enable students to stay informed about any changes or 

updates to campus structures, ensuring that they are always up-to-date with the latest 

information. 

In addition, AR Campus Connect offers social interaction features that enable users to engage 

with one another. Users can create new posts or react to existing ones by liking, disliking, or 

commenting, thereby providing a platform for meaningful connections between UTAR 

students. The system also includes event-related features, allowing users to post and view 

upcoming events, which helps UTAR students stay informed about campus activities. These 

functionalities not only enhance user engagement but also foster a sense of community and 

connectivity within the campus. 
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7.2  Recommendation 

While the AR Campus Connect system is largely functional, it could benefit from additional 

interactive features, such as messaging and following. Currently, the system only supports 

interactions through liking, disliking, or commenting, which limits users' ability to establish 

deeper connections. To enhance the social experience, future updates could include a 

messaging feature, enabling students to privately communicate and foster stronger 

relationships. Additionally, implementing a follow feature would allow users to stay updated 

with each other's latest activities and news. 
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APPENDIX 

 

FINAL YEAR PROJECT WEEKLY REPORT 

(Project II) 

 

Trimester, Year: Y3S3 Study week no.: 4 

Student Name & ID: Tay Min Min (21ACB03903) 

Supervisor: Dr. Cheng Wai Khuen 

Project Title: AR Campus Connect: Enhancing Social Connectivity through Augmented 

Reality in University Settings 

 

 

1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 

 

 

Switched platform from Android Studio to Unity 
 

 

2. WORK TO BE DONE 

 

Setting up system environment for AR 

 

 

3. PROBLEMS ENCOUNTERED 

 

 

Unfamiliar with Unity, setting up took a lot of time 

 

 

 

 

 

4. SELF EVALUATION OF THE PROGRESS 

 

 

Good direction, since Android Studio is unable to produce desired result 

 

 

 

 

 

 

 

 _________________________      _________________________ 

 Supervisor’s signature              Student’s signature 
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FINAL YEAR PROJECT WEEKLY REPORT 

(Project II) 

 

Trimester, Year: Y3S3 Study week no.: 6 

Student Name & ID: Tay Min Min (21ACB03903) 

Supervisor: Dr. Cheng Wai Khuen 

Project Title: AR Campus Connect: Enhancing Social Connectivity through Augmented 

Reality in University Settings 

 

 

1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 

 

- Set up the environment for AR 

- place anchors in campus area 
 

 

2. WORK TO BE DONE 

 

Modify the anchor to display canvas in real world 

 

 

3. PROBLEMS ENCOUNTERED 

 

 

Struggle to design the canvas as the operation method is different with what I usually use 

 

 

 

 

 

4. SELF EVALUATION OF THE PROGRESS 

 

 

A bit slow. I was going to start designed the UI for pages this week. 

 

 

 

 

 

 

 

       

_________________________       _________________________ 

 Supervisor’s signature              Student’s signature 
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FINAL YEAR PROJECT WEEKLY REPORT 

(Project II) 

 

Trimester, Year: Y3S3 Study week no.: 8 

Student Name & ID: Tay Min Min (21ACB03903) 

Supervisor: Dr. Cheng Wai Khuen 

Project Title: AR Campus Connect: Enhancing Social Connectivity through Augmented 

Reality in University Settings 

 

 

1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 

 

 

Real world canvas set up & design completed 
 

 

2. WORK TO BE DONE 

 

UI design for pages 

 

 

3. PROBLEMS ENCOUNTERED 

 

 

N/A 

 

 

 

 

 

4. SELF EVALUATION OF THE PROGRESS 

 

Progressing nicely! 

 

 

 

 

 

 

 

 

 _________________________      _________________________ 

 Supervisor’s signature              Student’s signature 
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FINAL YEAR PROJECT WEEKLY REPORT 

(Project II) 

 

Trimester, Year: Y3S3 Study week no.: 10 

Student Name & ID: Tay Min Min (21ACB03903) 

Supervisor: Dr. Cheng Wai Khuen 

Project Title: AR Campus Connect: Enhancing Social Connectivity through Augmented 

Reality in University Settings 

 

 

1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 

 

Completed UI design for pages 
 

 

 

2. WORK TO BE DONE 

 

- fix interaction of AR elements to display pages 

- code for page interactions 

 

 

3. PROBLEMS ENCOUNTERED 

 

- clicking on AR elements does not redirect to other pages 

 

 

 

 

 

 

4. SELF EVALUATION OF THE PROGRESS 

 

Progress went well and although a few errors were encountered, they were able to be 

resolved in a short period of time. 

 

 

 

 

 

 

 

 _________________________      _________________________ 

 Supervisor’s signature              Student’s signature 
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FINAL YEAR PROJECT WEEKLY REPORT 

(Project II) 

 

Trimester, Year: Y3S3 Study week no.: 12 

Student Name & ID: Tay Min Min (21ACB03903) 

Supervisor: Dr. Cheng Wai Khuen 

Project Title: AR Campus Connect: Enhancing Social Connectivity through Augmented 

Reality in University Settings 

 

 

1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 

 

 

- Fixed AR elements interaction 
 

 

2. WORK TO BE DONE 

 

- solve page interactions bugs 

- modify UI 

- documentation 

- test the final product in UTAR campus 

 

 

3. PROBLEMS ENCOUNTERED 

 

Unity became very laggy, sometimes I had to wait about 20 minutes – 3 hours just to run 

the application, and this greatly affected my programming & debug speed 

 

 

 

 

 

4. SELF EVALUATION OF THE PROGRESS 

 

 

Application works as expected, however, I spent too much time waiting for Unity to build 

the application. 

 

 

 

 

 

 

 

 _________________________      _________________________ 

 Supervisor’s signature              Student’s signature 
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